
Word Heads Read Me for Windows Users

Thank you for purchasing Word Heads. 

This Read Me file is a reference of commonly asked questions. It contains program installation 
instructions and troubleshooting tips as of the production of this CD. For the latest troubleshooting
information and Frequently Asked Questions, check out TechTalk on the Theatrix home page on 
the Internet: http://www.theatrix.com.

Please register your product via modem during installation or through the mail by sending in the 
registration card provided in the Word Heads box. 

TOPICS INCLUDED IN THE READ ME

I. Minimum Hardware and System Software Requirements
How to Locate System Information

II. Installation Section
How to Install
What's Installed and How to Uninstall

III. Electronic Registration

IV. Connecting to the Internet from the Word Heads CD-ROM
The Get Connected Application
AT&T WorldNet (SM) Service--Installing and Uninstalling

V. Windows Memory Problem/Solution Section
Virtual Memory on Windows 3.1

VI. Video Problem/Solution Section
256 Color Display

VII. Sound Problem/Solution Section
Sound Breaks up in the Program
No Sound or Poor Quality Sound
Testing Sound Card

VIII. CD-ROM Problem/Solution Section

IX. Other Problem /Solution Section
General Protection Fault (GPF in module xxxx)

X. Customer Service and Technical Support

-----------------------------------------------------------------------------------
I. Minimum Hardware and System Software Requirements
------------------------------------------------------------------------------------
- 486/66 MHz IBM-Compatible PC 
- 8 MB RAM (5 MB physical RAM available)
- 13 MB available hard disk space
- 256-color VGA monitor
- Double-speed CD-ROM drive
- Windows 3.1 or Windows 95
- 16-bit Windows-compatible sound card and speakers or headphones



Locating System Information on Windows 95
-----------------------------------------------------------------
1. From the "Start" button, choose "Settings," then select "Control Panel." Open "System." 
2. Under "Performance," note the amount of memory.
3. Under "Device Manager," click the plus sign next to "Sound, video and game controllers" and 
verify that there is a sound card installed.
4. On the Windows 95 desktop, double-click "My Computer." Click your hard drive with the right 
mouse button and select "Properties." This will show you how much hard disk space you have 
available.

Locating System Information on Windows 3.1
------------------------------------------------------------------
1. From the Help menu in Program Manager, select "About Program Manager." Note the system 
software version and the amount of free Memory. 
2. From Program Manager, select "Main" then "Control Panel." Choose "386 Enhanced." Click on 
"Virtual Memory." Note the size of the swap file and whether it's temporary or permanent.
3. More information is available by looking at Microsoft Diagnostics Screens. To review MSD 
data, select "DOS Prompt" from "Main." Type MSD and press Enter.
4. To return to Windows, type "Exit" and press "Enter."

-------------------------------
II. Installation Section
-------------------------------

The Word Heads Installer will install the Word Heads application and the system software 
required to run the Word Heads application. The Word Heads CD must always be in your CD-
ROM drive to run Word Heads. 

To get the best performance, turn off screen saver programs and close all other applications 
before running the installation.

If you have less than 24 MB RAM, Word Heads will work best with Virtual Memory turned on. See
the Memory section for directions on how to change this setting.

Word Heads runs best in 256 colors. See Video Problem/Solution Section for directions on how to
configure your video card to display 256 colors.

Windows 95
------------------
When you insert the Word Heads CD-ROM, you should get a dialog box that prompts you to 
Install Word Heads. If not:
1. From the "Start" menu, select "Settings," then "Control Panel," then "Add/Remove Programs." 
2. Make sure that your Word Heads CD is in the drive and select "Install."

Windows 3.1
-------------------
1. From Program Manager, choose "Run" from the "File" menu.
2. Enter: D:\SETUP (replacing "D" with the letter of your CD-ROM drive).
3. Follow the on-screen instructions. If necessary, you will be prompted to restart your computer 
before running Word Heads.

To start the program, double-click the "Theatrix" program group if it is not already open. Double-
click the "Word Heads" icon.

------------------------------------------------------
What's Installed and How to Uninstall



------------------------------------------------------

Windows 95
------------------
During installation, all the necessary files are copied into the Word Heads folder. To uninstall:
1. From the "Start" menu, select "Settings," then "Control Panel," then "Add/Remove Programs." 
2. Select "Word Heads."
3. Click the "Add/Remove" button, then click "Yes."

Windows 3.1
-------------------
During installation, all the necessary files are copied into the Word Heads folder. To uninstall:
1. Go to the Program Manager or File Manager.
2. Select "Run" from the "File" menu.
3. Enter: C:\WORDHEDS\UNINST16.EXE -FC:\WORDHEDS\DEISL1.ISU (If you installed Word 
Heads in a directory other than the default, replace both instances of "C:\WORDHEDS\" in the 
above with the drive:directory which contains Word Heads.)
4. If you installed Word Heads more than once, you may have several installation log files 
(DEISL1.ISU, DEISL2.ISU, etc.). The above command will uninstall Word Heads and delete 
DEISL1.ISU, leaving the other installation log files. You may delete these remaining files and the 
directory containing them.

--------------------------------------
III. Electronic Registration
--------------------------------------
When you install Word Heads, you will be given the option of registering electronically,  If you 
choose not to register at this time, you can launch the electronic registration later by selecting 
"Register Word Heads" from the Theatrix Program Group on Windows 3.1 or from Start, 
Programs, Theatrix, Word Heads on Windows 95. 

----------------------------------------------------------------------------------------
IV. Connecting to the Internet from the Word Heads CD-ROM
-----------------------------------------------------------------------------------------

If you have access to the World Wide Web, you can access the Theatrix Web site directly from 
the "Get Connected" application on the Word Heads CD. World Wide Web access will 
supplement your experience of Word Heads, but it is not required to fully enjoy this product. 

To access Theatrix on the World Wide Web you will need:
1. A modem and a phone line or any Internet connection
2. An account with an Internet service provider 
3. Web browser software such as Netscape Navigatorª or Microsoft Internet Explorerª.

Once you're equipped to access the Web, you can get to Theatrix' Web site by selecting "Theatrix
on the WWW" from the "Get Connected" application. Windows 95 users can launch "Get 
Connected" by going to Start, Programs, Theatrix, Word Heads, WWW Access, Get Connected. 
Windows 3.1 users will find a Theatrix program group on their desktop from which they can 
double-click the "Get Connected" icon. The Word Heads CD-ROM must be in your CD-ROM drive
in order to run the Get Connected application.

Identifying Your Web Browser
-------------------------------------------
The first time you access the Theatrix Web site from "Get Connected," you may need to identify 
the location of your web browser on your hard drive. The program will search for common 
browsers on your hard drive and use one if it finds it. 



To select the browser that "Get Connected" will use:
1. Choose "Setup" from the "Get Connected" application. 
2. In the Setup dialog box, click the "Change Browser" button. 
3. Locate the Web browser that you wish to use on your computer's hard disk. 
4. When you have highlighted your browser, click "Open." 
5. Click "OK" at the original screen.

America Online Users
--------------------------------
In America Online versions 2.6 and later, access to the WWW is through a separate Web browser
application.

To select the AOL Web Browser application as the browser that "Get Connected" will use:
1. Choose "Setup." 
2. In the Setup dialog box, click the "Change Browser" button. 
3. Locate the file called "Web Browser" in a folder called "Online Browser" in the America Online 
folder on your computer's hard disk. 
4. When you have highlighted "Web Browser," click "Open." 
5. Click "OK" at the original screen.

Downloading May Interfere with Program Performance
------------------------------------------------------------------------------
If you play Word Heads while you are downloading files from the Internet, performance may be 
choppy and slow. If this is the case, wait until the files are completely downloaded before playing 
the program.

AT&T WorldNet Service
------------------------------------
For your convenience, this CD includes the Netscape Web browser and everything that you need 
to sign up for the AT&T WorldNet Service. If you already have an Internet service provider and 
browser software, our "Get Connected" application will make use of it and you will not need to 
install the AT&T WorldNet Service. 

Installing AT&T WorldNet Service
------------------------------------------------
After you've installed Word Heads, there will be an icon called "Install AT&T WorldNet" in the 
Theatrix Program Group on Windows 3.1 machines and in Start, Programs, Theatrix, Word 
Heads, WWW Access on Windows 95 machines. You can click it at any time to launch the AT&T 
WorldNet Service Installation.

Uninstalling AT&T WorldNet Service
----------------------------------------------------

Windows 3.1
-------------------
If you are using Windows 3.1 and you wish to remove the AT&T WorldNet Service software from 
your system, follow these steps:
1. Insert the Word Heads CD into your CD-ROM Drive. 
2. Select "Run" from the "File" menu in the "Program Manager" or "File Manager."
3. Type: D:\WNET16\DISK1\SETUP.EXE and click "OK" to launch the AT&T WorldNet Service 
installation. 
4. The installation program will tell you that you have a previous version of AT&T WorldNet 
Service or Netscape installed. Click "Continue." 
5. At the next screen, press the "Deinstall" button and the WorldNet files will be removed from 
your system.



Windows 95
------------------
To uninstall:
1. From the "Start" menu, select "Settings," then "Control Panel," then "Add/Remove Programs." 
2. Select "AT&T WorldNet Setup."
3. Click the "Add/Remove" button, then click "Yes."

---------------------------------------------------------------------
V. Windows Memory Problem/Solution Section
---------------------------------------------------------------------

Problem: Word Heads does not run/launch. 
---------------------------------------------------------------
Possible Cause: There may not be enough RAM available. 
Solution: You must have a minimum of 5 MB physical RAM available to run Word Heads 
(independent of Virtual Memory). 
1. Check Minimum System Requirements and verify you have the required memory. (See the 
Minimum Hardware and System Software Requirements section for directions.)
2. Quit other applications. 
3. If using Win 3.1,  turn on Virtual Memory, creating a swap file of at least 5 MB. Consider 
purchasing more RAM.

Windows 3.1: Turning on Virtual Memory
------------------------------------------------------------
For best performance, make certain that Virtual Memory is turned on, and that the swap file is set 
for at least 5120 KB. To do this:

1. From "Program Manager" choose "Main."
2. Select "Control Panel" then choose "386 Enhanced."
3. Click on "Virtual Memory" and note the "Size" of the current settings. If it is less than 5120 KB, 
continue.
4. Click on "Change" and locate the Recommended Maximum Size.
5. If the Recommended Maximum Size is 5120 KB or greater, change the New Size to 5120 KB. 
6. If the Recommended Maximum Size is less than 5120 KB, change the New Size to the number
that appears as the Recommended Maximum Size. NOTE: Do not increase the New size more 
than the Recommended size.
7. If the type of the swap file is not already "Permanent," make this change by selecting 
"Permanent" from the pull-down "Type" menu. 
8. It is recommended that you use 32 bit Disk/File Access, which allows the system to read and 
write files faster than before. If your hard drive has this option, a checkbox titled "Use 32 Bit Disk 
Access" will appear at the bottom of the Virtual Memory window. Make sure this box is selected. 
9. You must restart for the changes to take effect.

Memory and Performance on Win 3.1
------------------------------------------------------
On low end systems running Win 3.1, performance and some functionality in Word Heads may be
compromised. Upgrading to Windows 95 will significantly improve performance and overall 
stability of the program for most users.

----------------------------------------------------
VI. Video Problem/Solution Section
----------------------------------------------------

Setting Your Video Mode to 256 Colors
---------------------------------------------------------



WIN 95
-----------
1. From the "Start" menu, select "Setup" and then "Control Panel."
2. Choose "Display," then the "Settings" tab.
3. Change "Color Palette" settings to 256 by clicking the down arrow to the right of the current 
selection. 
4. Click "Apply."
5. You will be prompted to reboot your computer.

WIN 3.1
------------
1. Go to "Program Manager" and select "Main." 
2. From "Main" select "Windows Setup." 
3. Choose "Options" and select "Change System Settings." 
4. Click on the down arrow to the right of display selection and select an appropriate 256 color 
video driver for your system. NOTE: In some cases, you might be prompted to insert a disk from 
your Windows Installation disks. If this is the case, insert the prompted disk and let the system 
read it in order to make your change. 
5. Restart Windows.

To find out if your display card supports 256 colors, please consult the documentation that 
accompanied your computer or display adapter. 

Problem: Program Freezes when certain objects are clicked upon
-----------------------------------------------------------------------------------------------
Possible Cause: There could be a conflict with our products and earlier versions of certain video 
card drivers. 

Solution: Contact your video card manufacturer and ask for the latest updated video card driver 
version for your video card. In many cases, you can download the most current video drivers from
your manufacturer's Web site. 

Most video card manufacturers update their drivers at least once a year. We recommend that use
use the most current driver available.

----------------------------------------------------- 
VII. Sound Problem/Solution Section
-----------------------------------------------------

WINDOWS
-----------------

Problem: No sound or poor quality sound.
-------------------------------------------------------------
Possible Cause: There is a problem with your speaker set-up.
Solutions: Check the cables to your speakers. Check that your speakers are turned on and that 
the volume is set high enough.

Possible Cause: Conflict with other sound-related applications.
Solution: Check to see if you have another sound-related program open. Many programs do not 
free up the sound capabilities after they are loaded.

Possible Cause: The sound card is not installed correctly or needs an updated driver. 
Solutions: Consult the sound card's user manual to verify proper installation. Test other sound 
applications to see if they work correctly.



Possible Cause: Sound card software problem. 
Solution: We recommend you stay current (within a year) of the latest sound card driver provided 
by your manufacturer. To update your sound card driver, contact your sound card manufacturer  
and ask for the latest updated sound card driver version. In many cases, this information can be 
downloaded from their Web site. 

Problem: Volume control on Remote Control doesn't work
-----------------------------------------------------------------------------------
Possible Cause: Word Heads is unable to change the volume directly on certain sound cards.
Solution: Use your system controls to change the volume. 

----------------------------------------------------------
VIII. CD-ROM Problem/Solution Section
----------------------------------------------------------

Problem: "Please insert the Word Heads CD, then click 'Retry' to continue."
-------------------------------------------------------------------------------------------------------------
Possible Cause: The CD-ROM disc or drive may be dirty, or the CD is not in the drive. 
Solutions: If the CD is in the drive, the CD-ROM or the drive may be dirty. Gently rub the bottom 
of the CD-ROM with a clean, dry cloth. Clean the CD-ROM drive. Try another CD in the same 
drive to see whether the problem is with the CD or with the drive.

Possible Cause: The CD-ROM disc may be damaged.
Solutions: Attempt to read the CD-ROM disc on another CD-ROM disc drive. If the disc still fails 
to read, and it is a brand new disc, contact Technical Support to discuss your problem and 
determine if you need a replacement disc sent to you at no charge. 

--------------------------------------------------
IX. Other Problem/Solution Section
---------------------------------------------------

Problem: Program Crashes
----------------------------------------
Possible Cause: Inadequate RAM Memory
Solution: See Memory Section above.

Possible Cause: Program not properly installed.
Solution: Run installer again.

Problem: General Protection Fault (GPF)
------------------------------------------------------------
What should you do when you receive a GPF?

1. Write down the exact error message, including the module and the address.
2. If you have any other applications running, try to save your data and quit.
3. Restart your computer and stay in DOS before reentering Windows. (Don't type "WIN" at the 
DOS prompt.)
4. Depending on the severity of the crash, you may not be able to do Steps 2 and 3. If this is the 
case, you should reboot (Control-Alt-Delete). 
5. It may help to run SCANDISK, which corrects errors on your hard drive. At the DOS prompt 
type SCANDISK and press "Enter."

Windows 95
-------------------

Problem: script or -49 error



----------------------------------------
If you encounter a script or -49 error while playing Word Heads, there may be a conflict with other
applications running or printing on your computer. To resolve these conflicts, launch Word Heads 
without any other applications running or reboot your computer and try again. 

Windows 3.1
-------------------

McAfee Virus Utility
-----------------------------
If you are using a McAfee virus utility on Win 3.1, you may need to turn it off before running Word 
Heads. Windows 95 users can leave the McAfee virus utility on.

Problem: Problems installing with third-party shell managers.
-----------------------------------------------------------------------------------------
Possible Cause: Some shell managers can interfere with installations. 
Solution: Consult your shell manager's documentation for instructions on how to load the 
standard Windows Program Manager.

---------------------------------------------------------------
X. Customer Service and Technical Support
---------------------------------------------------------------
If you require technical support, please have the following information ready to help us quickly 
diagnose your problem:

1. The model, manufacturer and processor speed of your computer.
2. The operating system 
3. Total amount of RAM and amount of RAM available
4. Hard drive size and disk space available
5. Sound card Information and video card Information
6. Name of the program you are using
7. A detailed description of your problem. 

Phone: (415) 286-6110. Technical Support staff is available by phone Monday through Friday 
from 8 a.m. to 5 p.m. Pacific Time. 

E-Mail: support@theatrix.com. You will receive either an electronic response within two business 
days or information on how to access additional Theatrix Customer Support Services 
electronically.

World Wide Web: http://www.theatrix.com. Techtalk provides information on Frequently Asked 
Questions.  

Fax Support: (415) 286-6121. Our fax machine is available 24 hours a day. Faxes will be 
answered during our regular business hours within three business days.

Support By Mail
Theatrix Interactive
Attention: Technical Support 
1825 South Grant Street
San Mateo, CA 94403 
Please allow 10 business days for a mail response.

Customer Service: 800-943-3664
Customer Service E-Mail: info@theatrix.com



AT&T WorldNet Service: 800-400-1447


